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Kata Pengantar 

 

 

Tutorial ini dibuat sebagai panduan bagi para pengajar dan segenap 

civitas akademika dalam membuat dan membuat media digital (jurnalisme 

digital) yang dapat digunakan sebagai media publikasi dan panduan mengajar. 

Dalam tutorial ini akan dibahas (1) cara membuat email identitas (2) 

seluk beluk cara mempersiapkan bahan ajar Interaktif disertai dengan 

multimedia,(3) cara mempersiapkan sebuah situs online atau blog untuk 

publikasi bahan ajar (4) serta cara mempublikasi Online yang lebih menarik dan 

bermanfaat serta dapat diakses dengan mudah.  

Semoga tutorial ini dapat bermanfaat dan digunakan dengan sebaik-

baiknya. Bila ada kekurangan, kritik dan saran serta pertanyaan dapat diemail 

ke: iferianto@yahoo.com 

 

 

Purwokerto, 18 Oktober 2010 

Penyusun 

 

Imam Ferianto 
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I. Pendahuluan 

 

Seiring dengan kemajuan teknologi dan 

perkembangan dunia ajar. Sudah 

saatnya kita dapat memanfaatkan 

keberadaan teknologi tersebut untuk 

meningkatkan mutu pendidikan.  Salah 

satunya yaitu dengan menyediakan 

bahan ajar yang mudah diperoleh, 

dimengerti dan menarik untuk dibaca. Pemanfaatan bahan ajar yang sering 

disebut E-Learning ini banyak sekali keuntungannya. Dalam bahasan ini akan 

dikupas tentang bagaimana membuat multimedia interaktif e-learning dan 

cara publikasinya menggunakan web blogs. 

Multimedia mempunyai definisi yang luas yang dapat dijabarkan dalam 

beragam media. Dalam hal publikasi online yang kita bahas disini adalah 

multimedia berupa audio visual dan representasi dalam bentuk animasi 

gambar dan suara untuk mendukung dan menjelaskan apa yang dimaksud 

dalam content. Multimedia sangat efektif untuk menarik minat pembaca 

membuat betah dan tidak bosan dalam menjabarkan materi secara visual 

sehingga apa yang dimaksud dalam kontent lebih dapat dipahami. 

Media online sangat banyak jenisnya, salah satu yang sering kita akses 

yang disebut website merupakan media jurnalisme online. Blog merupakan 

salah satu dari jenis website yang dapat kita manage sendiri dan disediakan 

gratis oleh beberapa layanan .  
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Sedangkan email merupakan sarana komunikasi online yang mutlak 

diperlukan dalam dunia online atau maya. Email berfungsi sebaga sarana saling 

berkirim surat elektronik (baca: kotak pos online) dan juga sebagai identitas 

diri (baca: KTP Online). Sebelum memulai publikasi online, kita diwajibkan 

untuk membuat email. 

Beragam hal tersebut diatas akan kita bahas satu-persatu demi 

mewujudkan suksesnya membuat bahan ajar online (baca: e-learning) 
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II. Membuat Account Email  

 

Fungsi Email 

Email merupakan sarana komunikasi atau identitas yang 

dapat disamakan dengan sebuah Kotak pos dan juga KTP 

dalam dunia nyata. Email ini befungsi ganda seperti yang 

telah disebutkan: 

1. Sebagai sarana berkirim email surat dan sebagainya, email merupakan 

kotak pos yang efektif, cepat dan delivery order. Sekali kirim kita dapat 

menyampaikan untuk banyak orang dan dapat disertai dengan 

attachment dan lainnya ke tempat yang jauh sekalipun. Sudah bukan 

jamanya lagi berkirim surat dan SMS. Gunakan email untuk komunikasi 

efektif, murah dan mudah. 

2. Sebagai sarana identitas diri. Email dalam banyak hal berfungsi seperti 

KTP digital yang digunakan unutk melakukan verifikasi apakah benar 

akun yang akan kita buat merupakan manusia dan bersumber dari orang 

yang benar? Email akan digunakan oleh penyedia berbagai layanan 

untuk melakukan konfirmasi dan verifikasi akun yang dibuat misalnya 

blog, yahoo messenger, facebook, koprol dan lainnya. Karena itu 

memiliki email adalah “wajib” bagi yang akan menggunakan media 

online dan internet. 
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Ragam Penyedia Email 

Email banyak disediakan oleh beragam penyedia layanan, ada yang berbayar 

dan ada pula yang gratis. Dengan perbedaan layanan masing-masing seperti 

gratis akun, limit quota, gratis POP dan lainnya.  

Berikut beberapa site penyedia email gratis yang sering digunakan : 

Situs Pemilik Layanan 

www.plasa.com  Email, Web mail gratis 

Mail.yahoo.com Yahoo, inc Email, Web mail, Yahoo Messenger gratis 

Mail.yahoo.co.id  Email & Webmail, Google talk & SMTP dan 

POP 

Gmail.com Google Email & Webmail, Google talk & SMTP dan 

POP 

 

Istilah yang sering dalam dunia email 

#POP:  Post Office Protokol. Dapat digambarkan sebagau protocol untuk 

melakukan verifikasi email dan mengambil, biasanya protocol ini digunakan 

untuk mengambil email menggukan external tools (download email) misalnya 

menggunakan outlook dan lainnya. Jenisnya ada beragam misalnya POP, POP3. 

#SMTP: Simple Mail Transfer Protokol. Protokol ini biasanya digunakan untuk 

mengirimkan email. Jenisnya ada beragam misalnya SMTP, SMTPS. 

#Attachment: File yang disertakan dalam email. 

#Browse: memilih file yang akan diattachment 

#CC: Copy Carbon, artinya email akan dikirimkan copiannya ke orang lain 

(baca: tembusan dengan menyebutkan email lain yang juga dikirimi). 

 

http://www.plasa.com/


9 | P a n d u a n  M u l t i m e d i a  E - L e a r n i n g  B l o g  
 

#BCC: Blink copy carbon, artinya email akan dikirimkan kemail lain tanpa 

menyebutkan email lain yang dikirimi. 

#Reply: artinya membalas email 

#Compose: artinya menulis email 

 

Pada sesi kali ini kita akan belajar membuat dan menggunakan Gmail. Penulis 

lebih menyarankan gmail karena adanya responnya lebih cepat serta fitur 

SMTP dan POP gratis sehingga mail dapat kita download dan simpan di local 

computer kita. 
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Cara Membuat Account Gmail 

Buka browser anda (firefox atau internet explorer) 

ketik alamat http://gmail.com 

 

 

 

  

Click create 

account 

http://gmail.com/
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Contoh Pengisian Form Registrasi Gmail yang benar
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Lanjutkan ke tahap berikutnya, Bila ada error: perhatikan pesan erornya 

 

#Tampilan Akun Gmail Sukses Dibuat 

 

 

Tunggu sampai layout email di loading semua 
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Layout Gmail Default 

 

Berikut adalah layout Gmail default (Bahasa Inggris) 
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Setting Interface Bahasa Gmail 

 

Gmail dapat diubah menggunakan bahasa Indonesia agar mempermudah kita 

menggunakan web email ini. Caranya adalah sbb: 

 Klik setting untuk mengubah tampilan bahasa ke Indonesia (gambar 

sebelumnya). 

 Kemudian  Pilih Gmail Display: Bahasa Indonesia 

 

 Kemudian Klik save changes, untuk menyimpan settingan tersebut 
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Tampilan Gmail dalam Bahasa Indonesia 
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Cara Berkirim Email 

Untuk mengirim email menggunakan Gmail caranya adalah sebagai berikut: 

 

 

Notifikasi Email Telah terkirim:
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Cara Melampirkan Berkas 

Berikut adalah cara melampirkan berkas (penjelasan dari langkah diatas bila 

ada file yang akan dikirimkan bersama dengan email) 

 

 

Selanjutnya tunggu lampiran tersebut di upload (lihat progress bar) 

 

 

Lampiran yang berhasil di upload dan siap dikirim
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Selanjutnya klik tombol kirim (seperti langkah sebelumnya) 

 

 

  



19 | P a n d u a n  M u l t i m e d i a  E - L e a r n i n g  B l o g  
 

Cara Mengirim Email ke Banyak Alamat 

Untuk  mengirim email ke banyak alamat email tujuan, tuliskan alamat email 

tujuan, dan tuliskan juga pada BCC disertai tanda koma “,”  untuk memisahkan  

email dengan email lainnya.  

Contoh Pengisian: 

 

Cara Menambahkan BCC 
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Cara Membuka Email 

Untuk membuka email klik Kotak Masuk  (Disebelah Kiri) 

 

 

Tampilan Email yang telah dibuka  

(tampak attachment lampiran gambar dalam email) 
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Cara Mendownload attachment Email 

Pada lampiran attachment, klik tombol unduh untuk mendownload 

attachment dan menyimpan ke local computer 
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III.Membuat Bahan Ajar Multimedia 

(Menggunakan Camtasia) 

 

Camtasia merupakan produk dari www.techsmith.com , 

berupa sejenis tool untuk membuat tutorial penggunaan 

komputer dengan mudah. Tool ini serupa dengan screen 

recorder yang akan merekan keseluruhan aktivitas kita 

menggunakan computer dalam bentuk movie yang selanjutnya 

dapat diedit dan disisipi catatan lain. Tool ini akan 

mempermudah kita dalam membuat bahan ajar multimedia. Sebenarnya 

banyak tool sejenis camtasia seperti fastone, screen record dan beragam nama 

produk lain. Tetapi untuk sekarang (2010) camtasia adalah 1 diantara yang 

terbaik, Included recording dan editing dalam 1 paket. 

Instalasi Tool Camtasia 

Untuk menginstall camtasia click setup.msi yang terdapat dalam cd tutorial ini . 

Ikuti terus dengan tombol next. 

http://www.techsmith.com/
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Masukan key bila mempunyai lisence atau pilih 30 day evaluation bila ingin 

mencoba selama 30 hari. 
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Dan ikuti langkah selanjutnya dengan next sampai screen terahir, instalasi. 

 

Instalasi Selesai 
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Buka dan jalankan camtasia dari menu:  

 Start -> Program File.  
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Menu Camtasia Studio 
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Penjelasan Singkat Menu Camtasia 

(dari menu help) 

 

 

 

Menu utama yang paling banyak digunakan: Record the Screen, Import Media, Produce 
and Share your video.  

 

Menu Options 
Access project, import dan opsi batch seperti juga fungsi penting lain. 
Contohnya: Snapping options, Playback controls, and User-to-User Forums 

 

Editing Dimensions 
Pilih dimensi untuk mengedit video anda. Untuk hasil terbaik, pilih ukuran yang diinginkan 
untuk video final.  

 

Menu bantuan menggunakang Camtasia Studio 7 

 

Pilih Help > Camtasia Studio Help atau klik icon help (ikon tanda Tanya). Help 

mempunyai semua petunjuk yang diperlukan untuk mengoperasikan camtasia 7.  

Klik pada ikon:  learning center, untuk membuka tutorial pada website techsmith 

camtasia. 

 

 

Clip Bin 
Terdiri dari semua video, audio, and image clips yang diimported ke project sekarang. 

 

Library 
menyimpan timeline sequences, video, audio,  image clips, dan asset lain yang digunakan 
oleh projek. 

1 

2 

3 

4 

5 

6 

mk:@MSITStore:C:/Program%20Files/TechSmith/Camtasia%20Studio%207/CamtasiaStudio.chm::/2_Record.2.1.html#9000001
mk:@MSITStore:C:/Program%20Files/TechSmith/Camtasia%20Studio%207/CamtasiaStudio.chm::/3_Edit.3.10.html#9000264
mk:@MSITStore:C:/Program%20Files/TechSmith/Camtasia%20Studio%207/CamtasiaStudio.chm::/4_Produce.4.1.html#9000001
mk:@MSITStore:C:/Program%20Files/TechSmith/Camtasia%20Studio%207/CamtasiaStudio.chm::/4_Produce.4.1.html#9000001
mk:@MSITStore:C:/Program%20Files/TechSmith/Camtasia%20Studio%207/CamtasiaStudio.chm::/3_Edit.3.7.html#9000153
mk:@MSITStore:C:/Program%20Files/TechSmith/Camtasia%20Studio%207/CamtasiaStudio.chm::/3_Edit.3.9.html#9000210
mk:@MSITStore:C:/Program%20Files/TechSmith/Camtasia%20Studio%207/CamtasiaStudio.chm::/3_Edit.3.11.html#9000293
mk:@MSITStore:C:/Program%20Files/TechSmith/Camtasia%20Studio%207/CamtasiaStudio.chm::/3_Edit.3.14.html#9000394
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Task Tabs 
Klik tab untuk membuka effects dan opsi editing. Double-click element (callouts, zoom 
keyframes, etc.) pada timeline untuk otomatis membuka tab terkait. 

 

More Tab 
Click to access more task tabs. 

 

Timeline Toolbar 
Merupakan tool dasar untuk undo dan redo, cut, split, dan lainya. 

 

Timeline Tracks 
Merupakan semua sequence(kumpulan frame) berurutan dari klip dan efek pada video. 
Setiap trak terdiri dari beberapa jenis element. contohnya: callouts, cursor keyframes, or 
audio. 

 

Timeline  
Berguna untuk mengedit track video 

 

 

 

 

  

7 

8 

9 

10 

11 

mk:@MSITStore:C:/Program%20Files/TechSmith/Camtasia%20Studio%207/CamtasiaStudio.chm::/3_Edit.3.18.html#9000544
mk:@MSITStore:C:/Program%20Files/TechSmith/Camtasia%20Studio%207/CamtasiaStudio.chm::/3_Edit.3.24.html#9000781
mk:@MSITStore:C:/Program%20Files/TechSmith/Camtasia%20Studio%207/CamtasiaStudio.chm::/3_Edit.3.26.html#9000795
mk:@MSITStore:C:/Program%20Files/TechSmith/Camtasia%20Studio%207/CamtasiaStudio.chm::/3_Edit.3.19.html#9000609
mk:@MSITStore:C:/Program%20Files/TechSmith/Camtasia%20Studio%207/CamtasiaStudio.chm::/3_Edit.3.18.html#9000544
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Memulai Project Camtasia 

Penggunaan camtasia sebenarnya mudah, hanya cukup buat project dan 

record screen, dan selesai lalu publish menjadi video atau web video. 

Hal yang lumayan sulit adalah mengedit video tersebut dan menambahkan 

note serta efek-efek tertentu yang membutuhkan ketelitian dalam mengeset 

timeline dan mengatur resource serta ketekunan dalam mengedit. 

Tetapi environtment camtasia 7 sudah sangat memudahkan anda untuk 

melakukan semua hal tersebut. 

 

Untuk memulai project camtasia click menu: File->New Project. 

 

 

Kemudian click : Record Screen. 
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Memilih Ukuran Recording dan Object yang Akan direkam 

 

 Fullscreen: Bila Ingin merekam seluruh aktivitas layar, seukuran monitor 

 Custom: Bila ingin merekam hanya daerah tertentu atau memilih 

window tertentu saja. 

 
 Webcam off/on: Menampilkan webcam (record akan disertai tampilan 

webcam dari yang merecord) 

 Audio on/off: Untuk mengeset audio on atau tidak selama recording 

 

Jika telah siap untuk merekam, click tombol  Record, dan tekan F10 

untuk menghentikan recording 
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Contoh Preview Hasil recording 

 

Setelah selesai click tombol Save dan Edit, kemudian akan ditampilkan tombol 

save:  (isikan nama file video rekaman: xxxx.camrec) dan klik save 

 
Langkah selanjutnya dilanjukan ke video Editor. 
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Pemilihan Ukuran Video Editing 

Bila ditampilkan ukuran video editor, pilih sesuai ukuran screen misalnya 

1024x768 pixel, atau bila diinginkan output untuk membuat sebuah VCD pilih 

640x359pixel. Atau pilih sesuai yang diinginkan bila untuk publikasi web. 
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Video Editor Layout 

Gambar video telah terekam dalam editor dan siap diedit 
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Penambahan Callout  

Callout: adalah keterangan semacam notes yang ditampilkan diatas video. 

Callout ini dapat diset jenis, ukuran font, warna transparansi, ukuran, letak, 

serta waktu callout tersebut ditampilkan. Callout sendiri mempunyai animasi 

default semacam splash yang muncul dan menghilang. 

 

 

Setting Callout 

 

Untuk mengahiri callout, klik pada sembarang area di timeline atau 

videopreview. 
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Setting Waktu Callout dan Tampilan Antar Callout 

Tampak window timeline sudah dizoom dan Callout 2 Muncul setelah Callout 1 

 

 

Melakukan Produksi Video 

Untuk membuat video pilih menu File-> Product and Share 
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Pilih target produk video 

Misalkan web: untuk keperluan publishing di website, dan click next  

 
 

Render Output 

Isikan nama File dan Pilih Folder output 
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Tunggu Sampai Proses Rendering sampai selesai 

Rendering adalah mengubah 

dan menyusun tiap frame 

menjadi sebuah video utuh 

yang dapat dilihat (misal ke 

MPG, AVI, FLV). 

 

Proses rendering selesai dan ditampilkan summary dari video out 

Video siap untuk dipublish dan digunakan pada website atau blogs. 
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Hasil Publikasi Multimedia Pada Website 

Contoh Video Hasil yang ditampilkan pada website 

 

*Catatan: Cara mengupload Hasil video render ini pada blog atau website akan 

dibahas pada sesi terahir tutorial. 
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IV. Gambaran Umum E-Learning  

 

Definisi E-Learning 

Sekilas perlu kita pahami ulang apa e-Learning itu 

sebenarnya. ELearning adalah pembelajaran jarak 

jauh (distance Learning) yang memanfaatkan 

teknologi komputer, jaringan komputer dan/atau 

Internet. E-Learning  memungkinkan pembelajar 

untuk belajar melalui komputer di tempat mereka 

masing-masing tanpa harus secara fisik pergi 

mengikuti pelajaran/perkuliahan di kelas. E-Learning sering pula dipahami 

sebagai suatu bentuk pembelajaran berbasis web yang bisa diakses dari 

intranet di jaringan lokal atau internet. Sebenarnya materi e-Learning tidak 

harus didistribusikan secara on-line baik melalui jaringan lokal maupun 

internet, distribusi secara off-line  menggunakan media CD/DVD pun termasuk 

pola e-Learning. Dalam hal ini aplikasi dan materi belajar dikembangkan sesuai 

kebutuhan dan didistribusikan melalui media CD/DVD, selanjutnya pembelajar 

dapat memanfatkan CD/DVD tersebut dan belajar di tempat di mana dia 

berada. 

 

Ada beberapa pengertian berkaitan dengan e-Learning sebagai berikut : 

 

 * Pembelajaran jarak jauh.  

E-Learning memungkinkan pembelajar untuk menimba ilmu tanpa harus 

secara fisik menghadiri kelas. Pembelajar bisa berada di Semarang, sementara 

“instruktur” dan pelajaran yang diikuti berada di tempat lain, di kota lain 

bahkan di negara lain. Interaksi bisa dijalankan secara on-line dan real-time 

ataupun secara off-line atau archieved. 

Pembelajar belajar dari komputer di kantor ataupun di rumah dengan 

memanfaatkan koneksi jaringan lokal ataupun jaringan Internet ataupun 

menggunakan media CD/DVD yang telah disiapkan. Materi belajar dikelola oleh 

http://elearning.gunadarma.ac.id/index.php?option=com_content&task=view&id=13
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sebuah pusat penyedia materi di kampus/universitas, atau perusahaan 

penyedia content tertentu. Pembelajar bisa mengatur sendiri waktu belajar, 

dan tempat dari mana ia mengakses pelajaran. 

 

 

 

* Pembelajaran dengan perangkat komputer 

E-Learning disampaikan dengan memanfaatkan perangkat komputer. Pada 

umumnya perangkat dilengkapi perangkat multimedia, dengan cd drive dan 

koneksi Internet ataupun Intranet lokal. Dengan memiliki komputer yang 

terkoneksi dengan intranet ataupun Internet, pembelajar dapat berpartisipasi 

dalam e-Learning. Jumlah pembelajar yang bisa ikut berpartisipasi tidak 

dibatasi dengan kapasitas kelas. Materi pelajaran dapat diketengahkan dengan 

kualitas yang lebih standar dibandingkan kelas konvensional yang tergantung 

pada kondisi dari pengajar. 

 

* Pembelajaran formal vs. informal  

E-Learning bisa mencakup pembelajaran secara formal maupun informal. E-

Learning secara formal, misalnya adalah pembelajaran dengan kurikulum, 

silabus, mata pelajaran dan tes yang telah diatur dan disusun berdasarkan 

jadwal yang telah disepakati pihak-pihak terkait (pengelola e-Learning dan 

pembelajar sendiri). Pembelajaran seperti ini biasanya tingkat interaksinya 

tinggi dan diwajibkan oleh perusahaan pada karyawannya, atau pembelajaran 

jarak jauh yang dikelola oleh universitas dan perusahaan-perusahaan (biasanya 

perusahan konsultan) yang memang bergerak di bidang penyediaan jasa e-

Learning untuk umum. E-Learning bisa juga dilakukan secara informal dengan 

interaksi yang lebih sederhana, misalnya melalui sarana mailing list, e-

newsletter atau website pribadi, organisasi dan perusahaan yang ingin 

mensosialisasikan jasa, program, pengetahuan atau keterampilan tertentu 

pada masyarakat luas (biasanya tanpa memungut biaya). 
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* Pembelajaran yang ditunjang oleh para ahli di bidang masing-masing.  

Walaupun sepertinya e-Learning diberikan hanya melalui perangkat komputer, 

e-Learning ternyata disiapkan, ditunjang, dikelola oleh tim yang terdiri dari 

para ahli di bidang masing-masing, yaitu: 

1. Subject Matter Expert (SME) atau nara sumber dari pelatihan yang 

disampaikan. 

2. Instructional Designer (ID), bertugas untuk secara sistematis mendesain 

materi dari SME menjadi materi e-Learning dengan memasukkan unsur 

metode pengajaran agar materi menjadi lebih interaktif, lebih mudah 

dan lebih menarik untuk dipelajari. 

3. Graphic Designer (GD), mengubah materi text menjadi bentuk grafis 

dengan gambar, warna, dan layout yang enak dipandang, efektif dan 

menarik untuk dipelajari. 

4. Ahli bidang Learning Management System (LMS). Mengelola sistem di 

website yang mengatur lalu lintas interaksi antara instruktur dengan 

siswa, antarsiswa dengan siswa lainnya.  

Di sini, pembelajar bisa melihat modul-modul yang ditawarkan, bisa 

mengambil tugas-tugas dan test-test yang harus dikerjakan, serta melihat 

jadwal diskusi secara maya dengan instruktur, nara sumber lain, dan 

pembelajar lain. Melalui LMS ini, siswa juga bisa melihat nilai tugas dan test 

serta peringkatnya berdasarkan nilai (tugas ataupun test) yang diperoleh. 

E-Learning tidak diberikan semata-mata oleh mesin, tetapi seperti juga 

pembelajaran secara konvensional di kelas, e-Learning ditunjang oleh para ahli 

di berbagai bidang terkait. E-learning jenis ini merupakan sebuah system 

informasi terstruktur yang dibentuk dalam Aplikasi E-Learning LMS. 
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Plus Minus E-learning 

Seperti Sebagaimana yang disebutkan di atas, e-learning telah mempersingkat 

waktu pembelajaran dan membuat biaya studi lebih ekonomis. E-learning 

mempermudah interaksi antara peserta didik dengan bahan/materi, peserta 

didik dengan dosen/guru/instruktur maupun sesama peserta didik. Peserta 

didik dapat saling berbagi informasi dan dapat mengakses bahan-bahan belajar 

setiap saat dan berulang-ulang, dengan kondisi yang demikian itu peserta didik 

dapat lebih memantapkan penguasaannya terhadap materi pembelajaran. 

Dalam e-learning, faktor kehadiran guru atau pengajar otomatis menjadi 

berkurang atau bahkan tidak ada. Hal ini disebabkan karena yang mengambil 

peran guru adalah komputer dan panduan-panduan elektronik yang dirancang 

oleh "contents writer", designer e-learning dan pemrogram komputer. 

Kuntungan dengan adanya e-learning para guru/dosen/instruktur akan lebih 

mudah : 

1. melakukan pemutakhiran bahan-bahan belajar yang menjadi tanggung 

jawabnya sesuai dengan tuntutan perkembangan keilmuan yang mutakhir 

2. mengembangkan diri atau melakukan penelitian guna meningkatkan 

wawasannya 

3. mengontrol kegiatan belajar peserta didik. 

Kehadiran guru sebagai makhluk yang hidup yang dapat berinteraksi secara 

langsung dengan para murid telah menghilang dari ruang-ruang elektronik e-

learning ini. Inilah yang menjadi ciri khas dari kekurangan e-learning yang tidak 

bagus. Sebagaimana asal kata dari e-learning yang terdiri dari e (elektronik) 

dan learning (belajar), maka sistem ini mempunyai kelebihan dan kekurangan. 

 

  

http://id.wikipedia.org/wiki/Pembelajaran_elektronik
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Sejarah dan Perkembangan E-learning 

E-pembelajaran atau pembelajaran elektronik pertama kali diperkenalkan oleh 

universitas Illinois di Urbana-Champaign dengan menggunakan sistem instruksi 

berbasis komputer (computer-assisted instruction ) dan komputer bernama 

PLATO. Sejak itu, perkembangan E-learning dari masa ke masa adalah sebagai 

berikut: 

(1) Tahun 1990 : Era CBT (Computer-Based Training) di mana mulai 

bermunculan aplikasi e-learning yang berjalan dalam PC standlone ataupun 

berbentuk kemasan CD-ROM. Isi materi dalam bentuk tulisan maupun 

multimedia (Video dan AUDIO) DALAM FORMAT mov, mpeg-1, atau avi. 

(2) Tahun 1994 : Seiring dengan diterimanya CBT oleh masyarakat sejak tahun 

1994 CBT muncul dalam bentuk paket-paket yang lebih menarik dan diproduksi 

secara massal. 

(3) Tahun 1997 : LMS (Learning Management System). Seiring dengan 

perkembangan teknologi internet, masyarakat di dunia mulai terkoneksi 

dengan internet. Kebutuhan akan informasi yang dapat diperoleh dengan 

cepat mulai dirasakan sebagai kebutuhan mutlak , dan jarak serta lokasi 

bukanlah halangan lagi. Dari sinilah muncul LMS. Perkembangan LMS yang 

makin pesat membuat pemikiran baru untuk mengatasi masalah 

interoperability antar LMS yang satu dengan lainnya secara standar. Bentuk 

standar yang muncul misalnya standar yang dikeluarkan oleh AICC (Airline 

Industry CBT Commettee), IMS, SCORM, IEEE LOM, ARIADNE, dsb. 

(4) Tahun 1999 sebagai tahun Aplikasi E-learning berbasis Web. Perkembangan 

LMS menuju aplikasi e-learning berbasis Web berkembang secara total, baik 

untuk pembelajar (learner) maupun administrasi belajar mengajarnya. LMS 

mulai digabungkan dengan situs-situs informasi, majalah, dan surat kabar. 

Isinya juga semakin kaya dengan perpaduan multimedia , video streaming, 

serta penampilan interaktif dalam berbagai pilihan format data yang lebih 

standar, dan berukuran kecil. 
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ELearning 2.0 

Istilah e-Learning 2.0 digunakan untuk merujuk kepada cara pandang baru 

terhadap pembelajaran elektronik yang terinspirasi oleh munculnya teknologi 

Web 2.0. Sistem konvensional pembelajaran elektronik biasanya berbasis pada 

paket pelajaran yang disampaikan kepada siswa dengan menggunakan 

teknologi Internet (biasanya melalui LMS: moodle, olat, dukeos, dan lainnya). 

Peran siswa dalam pembelajaran terdiri dari pembacaan dan mempersiapkan 

tugas. Kemudian tugas dievaluasi oleh guru. Sebaliknya, e-learning 2.0 memiliki 

penekanan pada pembelajaran yang bersifat sosial dan penggunaan perangkat 

lunak sosial (social networking) seperti blog, wiki, podcast dan Second Life. 

Fenomena ini juga telah disebut sebagai Long Tail learning. 

Selain itu juga, E-learning 2.0 erat hubungannya dengan Web 2.0, social 

networking (Jejaring Sosial) dan Personal Learning Environments (PLE). 

 

  



45 | P a n d u a n  M u l t i m e d i a  E - L e a r n i n g  B l o g  
 

Beberapa Alternatif LMS System 

Moodle, MOODLE (singkatan dari Modular Object-Oriented Dynamic Learning 
Environment) A, free open-source PHP aplikasi web untuk memproduksi 
program berbasis internet modular yang mendukung pedagogi konstruksionis 
modern sosial. 

Docebo Digunakan dalam pengaturan pendidikan perusahaan dan lebih tinggi. 
Menawarkan dukungan untuk sejumlah model pembelajaran yang berbeda 
dan kompatibel dengan SCORM 1.2 dan 2004. Menawarkan antarmuka untuk 
sistem eksternal seperti konferensi video dan sistem SDM. 

eFront Instalasi dasar cukup minimalis, tetapi ini mudah diperluas dengan 
modul yang tersedia dari situs. versi Komersial dengan fitur-fitur tambahan 
juga tersedia. 

Dokeos Yang sangat baik fitur LMS yang juga menawarkan authoring konten 
dan alat video conferencing. Mendukung mengkonversi dokumen Office 
menjadi Belajar Paths. Penawaran pengguna sinkronisasi dengan sistem 
manajemen SDM seperti Oracle dan SAP. 

Claroline Lebih ditujukan pada pendidikan dari arena perusahaan, sistem ini 
didasarkan pada prinsip-prinsip pedagogis spesifik (seperti Moodle). 
Mendukung SCORM konten serta dibangun di Wiki dan alat konten online. 

ATutor Sebenarnya sebuah LCMS, ATutor juga menawarkan alat untuk 
pengelolaan pembelajaran. "A" adalah singkatan diakses dan memiliki 
dukungan yang bagus untuk standar-standar aksesibilitas kunci serta dukungan 
untuk SCORM, IMS dll 

ILIAS Menyediakan alat pengujian dan penilaian serta alat kolaborasi seperti 
chat dan forum, dan teknologi distribusi seperti RSS dan podcast. 

OLAT Sebuah sistem yang ditampilkan pada tahun kesepuluh pembangunan. 
Baru-baru ini pemenang "Belajar IMS Dampak 'Kepemimpinan Award' 2009 
untuk terbaik learning platform open source". 

Sakai Ditujukan Universitas, proyek ini memiliki peta jalan yang jelas dan telah 
tampak pembangunan cukup besar dalam beberapa tahun terakhir. Didukung 
oleh Yayasan Sakai yang mengelola hubungan dengan pendukung pendidikan 
dan komersial. 

http://moodle.org/
http://www.docebo.org/doceboCms/
http://www.efrontlearning.net/
http://www.dokeos.com/
http://www.claroline.net/
http://www.atutor.ca/
http://www.ilias.de/
http://www.olat.org/website/en/html/index.html
http://www.sakaiproject.org/portal
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.LRN Awalnya dikembangkan di MIT,. LRN mengklaim sebagai perusahaan kelas 
sumber yang paling banyak digunakan solusi LMS terbuka. 

openelms Dipasarkan secara khusus sebagai solusi bisnis, dan klaim basis 
pelanggan yang beragam yang berkisar dari Merrill Lynch kepada klub Queens 
Park Rangers sepak bola. 

Ganesha LMS ini dikembangkan oleh Anema, telah ada sejak tahun 2001 dan 
digunakan di beberapa organisasi besar. Situs, dan LMS itu sendiri, yang dalam 
bahasa Prancis tapi bisa diterjemahkan. 

 

Perbandingan Beberapa Platform Opensourece E-Learning LMS 

 

Sumber: http://e-learning-teleformacion.blogspot.com/2009/09/state-of-

learning-management-in-higher.html 

 

  

http://dotlrn.org/
http://www.openelms.org/
http://www.anemalab.org/
http://e-learning-teleformacion.blogspot.com/2009/09/state-of-learning-management-in-higher.html
http://e-learning-teleformacion.blogspot.com/2009/09/state-of-learning-management-in-higher.html
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V. Web Blogging, Fitur dan Persyaratannya 

 

Definisi Blog 

Blog merupakan kependekan dari asal muasal 

katanya yaitu WebLog = web+log. Yang merupakan 

penyebutan istilah “Logging The Web” adalah 

memasuki web dan menuliskan ‘kesimpulan link-

link mana yang menarik‘ dan memberikan 

pendapat tentang link tersebut di jurnal online 

mereka.  

Asal usul Blog 

Blog merupakan hasil evolusi dari diary online: Diary atau catatan harian 

mengenai pendapat, opini, dan apapun itu dalam bentuk yang dipublikasikan 

secara online (menggunakan website). Salah seorang pioneer dari internet-

based journalist ini adalah Justin Hall, yang melakukan membuat online 

diarynya Justin Links From The Underground ketika dia masih merupakan 

pelajar dari Swarthmore College. 

Kala itu, Blog (atau ketika itu bernama online diary) pada umumnya 

merupakan website yang berisi kumpulan link menuju halaman web lain yang 

disertai komentar dan opini pemilik online diary tersebut mengenai halaman 

dari tujuan link tersebut. Sehingga online diary ketika itu bisa juga dikatakan 

sebagai katalog link berdasarkan opini pemilik. Para diarist adalah editor yang 

memilih link mana yang menarik dan menampilkan link tersebut di online 

diarynya. 

http://bloggingly.com/sejarah-asal-usul-kemunculan-blog/


48 | P a n d u a n  M u l t i m e d i a  E - L e a r n i n g  B l o g  
 

Pada tahun 1997, Jorn Barger, seorang programer yang juga mengelola 

website online diary “robot wisdom” menciptakan istilah weblog yang diambil 

dari kata “logging the web”. Logging bisa diartikan masuk. So, logging the web 

bisa diartikan “memasuki web”. Korelasinya adalah blogger awal di kala itu 

merupakan orang yang masuk ke belantara web dan menyortir link-link 

menarik berdasarkan opininya. 

Hingga 1998, baru ada beberapa website yang dapat diidentifikasikan 

sebagai blog, hingga ketika itu menjelajahi semua weblog masih 

memungkingkan untuk di lakukan. Pada tahun 1999, Peter Merholz 

menyebutkan istilah weblog sebagai wee-blog, hingga akhirnya dibuat pendek 

menjadi blog saja. Orang yang mengelola blog kemudian di sebut “blogger”. 

Dari titik itulah semuanya berubah. Semakin hari, semakin banyak orang 

yang membuat blog. Pertumbuhan blog menjadi semakin signifikan ketika Pitas 

merilis Blogger.com pada Juli 1999. Blogger.com merupakan web service yang 

memungkinkan orang yang bahkan tidak memiliki kemampuan html sekalipun 

mampu menciptakan dan mengelola blog. Di titik ini, blog benar-benar 

berubah. Bahkan definisi blog mulai bergeser. 

Blog yang awalnya merupakan kumpulan link yang dikomentari oleh 

pemilik blog, mulai bergeser menjadi media ekspresi bebas semau pemilik blog 

yang ditampilkan secara kronologis terbalik. Dari sini, semuanya benar-benar 

berubah. Blog bertumbuh demikian cepat. Terlebih setelah Movable Type 

diluncurkan dan wordpress sebagai project kelanjutan cms b2 dirilis ke publik 

sebagai blog engine. 

Setelah itu, blog dan blogosphere terus berevolusi menjadi blogosphere 

dan muncul versi blog yang lain seperti wordpress, typepad dan lainnya. 
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Persyaratan Umum Mendaftar Blog 

Untuk mendaftar blog atau blog gratis secara umum yang diperlukan  adalah 

account email. Anda harus mempunyai sebuah account email aktif yang 

digunakan untuk verifikasi data account blog anda. Untuk yang belum memiliki 

email dapat dilihat pada cara pembuatan accout email di gmail.com diatas. 

Contoh email yang akan digunakan untuk mendaftarkan blog berikut adalah: 

imambloggers2010@gmail.com 
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Ragam Layanan Blog Gratis 

Berikut contoh beberapa situs yang menyediakan blog/gratis: 

Situs Pemilik Layanan Engine 

Blogdetik.com Detik Press Indonesia Blog gratis dengan nama 

http://nama.blogdetik.com 

WordpressMu 

Blogspot.com Google, inc Blog gratis dengan nama 

http://nama.blogspot.com 

Blogspot 

Wordpress.com Wordpress, inc Blog gratis dengan nama 

http://nama.wordpress.com 

Wordpress 

Blog.unsoed.ac.id Unsoed Blog gratis untuk dosen unsoed dengan 

nama 

http://nama.blog.unsoed.ac.id 

WordpresMu 

 

Fitur weblog 

Weblog terbaru mempunyai beragam fitur yang kaya tergantung add-on yang 

terpasang pada server. Secara umum dapat dikategorikan dalam tiga besar 

yaitu: 

 Publishing Text  & Rich tect HTML 

Blog mempunyai kemampuan melakukan publishing text HTML dengan 

mudah tanpa Harus tahu format dan TAG HTML, sebab sudah dilengkapi 

editor yang mirip dengan MSWORD. 

 Publishing Multimedia Image 

Blog mempunyai kemampuan publishing menggunakan gambar yaitu 

terdapat tools untuk upload dan menyisipkan gambar. 

 Publishing Multimedia Audio, Video  

Blog mempunyai kemampuan publishing multimedia audio dan video 

dengan mengupload video tersebut dan menyisipkannya dalam content 

HTML. 

 

http://nama.blogdetik.com/
http://nama.blogspot.com/
http://nama.wordpress.com/
http://nama.blog.unsoed.ac.id/
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VI. E-Learning Blog Menggunakan Wordpress 

 

Pemanfaatan Blog untuk E-Learning 

Blog sebagai media publikasi sangat layak dan efektif digunakan untuk E-

Learning. Ini tentu saja tergantung dan berkaitan dari content dan materi apa 

yang dimuat didalam blog, sehingga blog disebut layak menjadi media E-

Learning. Dalam bahasan berikutknya akan dibahas mengenai penggunaan 

wordpress untuk E-Learning publikasi bahan ajar dan multimedia yang telah 

kita persiapkan sebelumnya.  

 

Plus Minus Blog Sebagai Media E-Learning 

 

Kekurangan weblog adalah blog tidak mempunyai struktur hirarki dan konsep 

LMS yang terstuktur seperti engine LMS lain (moodle, olat dan lainnya). 

Sedangkan Kelebihan Weblog mempunyai dengan beragam fitur yang 

membebaskan seorang publisher dalam hal ini dosen/instruktur atau pengajar 

melakukan publishing content sesuai dengan apa yang diinginkan dan otoritas 

publikasi berada di tangan pemilik blog sepenuhnya. 

Sejarah Wordpress.com 

Wordpress.com merupakan salah satu komunitas  blog 

gratis terbesar saat ini yang mempunyai ribuan member 

didalamnya. Wordpress sendiri dikenal sebagai engine 

blog yang powerfull dan efisien untuk melakukan Online 

Publishing.  

WordPress dimulai pada tahun 2003 dengan bit kode tunggal untuk 

meningkatkan tipografi penulisan setiap hari yang mana beberapa orang yang 

suka menulis masih dapat dihitung dengan jari. Sejak saat itu, wordpress telah 

tumbuh menjadi alat blog hosting pribadi (self-hosted blogging) terbesar 

http://whalee.wordpress.com/2008/04/15/sejarah-wordpress/
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didunia. Telah digunakan ratusan ribu pemakai dan dilihat oleh 10 juta orang 

per harinya.  WordPress adalah proyek terbuka (open source), ada ratusan 

orang dari seluruh dunia yang bekerja didalamnya menciptakan Engine dan 

banyak fitur addon dari wordpress ini. 

Selain menyediakan blog gratis wordpress juga menyediakan Engine blog 

yang sama seperti yang digunakan di wordpress.com  untuk diinstall di server 

kita sendiri atau hostingan kita sendiri yang dapat di download di 

www.wordpress.org  , sehingga kita bisa mempunyai domain misalnya 

www.theferianto.com  yang dibangun menggunakan dasar engine wordpress 

tersebut. Ataupun menciptakan blog gratis untuk civitas akademik kampus 

misalnya  blog.unsoed.ac.id  menggunakan engine WordpresMu yang 

dikonfigurasi khusus pada server kampus sehingga nantinya bias mempunyai 

domain:   nama.blog.kampus.ac.id 

 

  

http://www.wordpress.org/
http://www.theferianto.com/
http://www.blog.unsoed.ac.id/
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Cara Mendaftar Akun Blog di Wordpress.com 

 

Untuk mendaftar akun blog di wordpress.com anda harus berkunjung ke 

http://www.wordpress.com , dan click tombol “sign up now”  yang berada di 

sebelah kanan atas. 

 

 

 

 

 

 

 

 

  

http://www.wordpress.com/
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Pengisian Form Pendaftaran BLog 

Langkah Selanjutnya isi form pendaftaran blog, berikut adalah contoh form 

yang benar. 

 

 

 

 

 



56 | P a n d u a n  M u l t i m e d i a  E - L e a r n i n g  B l o g  
 

Bila pada langkah sebelumnya Error, koreksi keselahan dan klik next lagi 

 

 

Konfirmasi Domain , Privasi & Judul Blog  
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Verifikasi Aktivasi Akun Blog 

Langkah selanjutnya adalah melakukan melengkapi data diri dan aktivasi blog 

 

 

Lengkapi dulu data diri anda dan simpan profile tersebut 

 

 

Buka email anda di Gmail yang berisi link Aktivasi 
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Klik link Verifikasi yang ada dalam email

 

 

Account Blog Telah aktif dan siap digunakan 
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Login Pada Blog www.wordpress.com  

Masukan username dan password, bila anda lupa password  

Klik link lost my password 

 

  

http://www.wordpress.com/
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Halaman Administrasi Blog (dashbord) 
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Daftar Menu Wordpress  

(menu wordpress umumnya terletak disebelah kiri) 
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Melakukan setting desain blog 

Untuk mengeset tampilan blog, klik pada menu Tampilan dan klik tema 
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Memulai Menulis Blogging 

Untuk memulai menulis ataupun mengedit tulisan yang ada klik menu tulisan yang ada pada 

menu disamping kiri. 
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Contoh Pengisian Posting yang benar dan Urut 
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Menyisipkan Gambar pada postingan 

Klik menu tambahkan gambar 

 

 

Setelah muncul window unggah gambar, maka
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Pilih gambar yang akan diupload dari local komputer 

 

 

Tunggu sampai proses upload selesai 
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Gambar yang berhasil diupload dan siap untuk disisipkan 
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Gambar yang berhasil disisipkan 

 

Selanjutnya Klik tombol terbitkan atau perbarui posting 

 

 

  



69 | P a n d u a n  M u l t i m e d i a  E - L e a r n i n g  B l o g  
 

Mengedit Posting yang telah ada 

Klik menu tulisan dan akan ditampilkan dari daftar tulisan yang ada 

 

 

Tampilan Layout Edit 

 (sama dengan tampilan add new) 
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Manajemen Komentar 

Klik pada menu komentar dan arahkan mouse pada komentar yang akan 

diterima, edit atau direply 

 

 

Mengahiri Posting 

Jangan lupa logout untuk menjaga keamanan blog anda bila telah selesai 

semua posting. 
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Upload content multimedia (Video) Pada wordpress 

 

Wordpress.com, secara default tidak membolehkan upload video, oleh karena 

itu kita harus mengupload video ke tempat lain, kemudian pada blog kita 

tampilkan coding untuk playernya. Lokasi untuk upload video beragam, disini 

saya contohkan menggunakan layanan video : youtube.com 

Lebih dulu kita login ke youtube.com atau membuat account baru di 

youtube.com bila belum punya. 

Registrasi Account pada Youtube.com 
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Contoh Pengisian Form Pendaftaran Yotube 

Lengkapi semua isian pada form dan click Accept 
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Menyisipkan content video pada wordpress 

Jika sudah berhasil mendaftar, anda tinggal login dan memulai upload Video 

pada youtube dan menyisipkan tag pada content postingan wordpress: 

[youtube=http://www.youtube.com/watch?v=XiUAPyyLiUw&fs=1&hl=en_US] 

http://www.youtube.com/watch?v=XiUAPyyLiUw&fs=1&hl=en_US , 

Merupakan alamat video anda yang sudah diUpload pada Youtube 

 

 

http://www.youtube.com/watch?v=XiUAPyyLiUw&fs=1&hl=en_US

